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Software

* LabVIEW
* LabVIEW Control Desigh and Simulation Module

—This module is used for creating Control and
Simulation applications with LabVIEW.

—Here you will find PID controllers, etc. The module is
available as a palette on your block diagram.

All LabVIEW Software can be downloaded here: www.ni.com/download




Contents

* Block Diagram Simulation based on
differential Equations

—Using the Simulation Loop
e PID Control with built-in PID blocks/functions
* Creating and using Simulation Subsystems

* Simulations using a While Loop with
Subsystems inside
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LabVIEW = Fun!

Graphical Programming:

* \Very different from traditional programming like VB, C#, Maple,
MATLAB, MathScript, etc.

 Itis more like a “drawing program” than a Programming Language

 This makes it easy to use for those who are not programmers (or
dont like programming ©)

 Excellent tool when using Hardware, when you need to take
Measurements (DAQ), etc.

 Itis fun and makes you very creative!



File Edit View [Project Operate Tools

Window Help

LabVIEW Example

LabVIEW has the same things as other programming languages, but in a graphical way!
Sequence Structure

Comment

While Loop

Sub VI Local Variable

2 Control
|':> @l gll : I-I@ -25 Il-ouI'E’ | 15pt Application Fpnt |~ ”gn' ”:ﬁ;' | |% “ :él / I..| Search 2, |-@ System
~
Stacked Sequence Structure] While Loo
Doo0oo0o0o0000000000000
Note! Replace this controller with
|Chart Initialization| your own Pl controller "Real Procdes" P
0 -~ Control Chart| [ =
=
PID Controller.vi] Vo M Izl Measurement Chart|
DEL
PID
Measurement Cha£| : rocess
0 71 _ 71 Setpoin
| 0 History PID Parameters|;
- P XScale.Multiplier ;
Control Chart |
> History DBL M
P XScale.Multiplier
? Sampling Time (s)] _
[[osLs Wait (ms)
1000 x (O Stop!
[ o I (o o o o o e o o o I B m = @
v
>

Arrays

Property Nodes

Constants

Case Structure Stop Button

(if-else)

Note! To do something with an object — Right-click on it

Condition
(When shall the loop end?)



Eront Panel LabVIEW Environment

i3 Untitled 8 Front Panel Ii”ﬂl&l

File Edit View Project Operate Tocls Window Help

Iq> ]@l :;\I ] ] I l 15pt Application Font |~ ngv H'-T]E" ”gv l lh‘%ﬁ?v H" Search 2 ” 2 I -

| ==L
-||é'

Create your User Interface/HMI here

-~

J

Note! Both the Front Panel and
the Block Diagram are stored in
one single file. These files are
called Vs (because the file
extensionis “vi”). VI = Virtual
Instruments

13 Untitled 8 Block Diagram

B S| 5
File Edit View Project Operate Tocols Window Help
> = \:@ IL;DIIE’ 7 | 15pt Application Font |~ HE;.V “'-T]Ev I I%?* Hi-”él I> Search 2, I =%

Switch between them: Ctrl + E

Block Diagram

Create your Code here




Controls and Functions Palette

e

X Controls ¢ You can “pin” them! —*|(& Functions

Available only from the Front Panel
You create your User Interface with help of
these Controls

Right-click on the Front Panel

2l .
Q, search ‘ o Wiew '
w  Modern
1 > > !obc > Gl
J!I.ZSE {" < {Path| o
Mumeric Boolean String & Path o
] > > 3- > —_—
& | =0 I==== M) Q
Array, Matrix... List & Table Graph -
o [ i =, -
a Enum l @ -l—‘
Ring & Enum Containers IjO o m—
B’ o b o =
. O L
Refnum Variant & Class Decorations o
P  Swystem O
» Classic Q)
» Express -
» Control Design & Simulation S
» .MET & Activex O
» Signal Processing >
» Addons GJ
» User Controls -
Select a Control... (qo]
| -
(@)
>

these Functions

L 11
QSearch ' o Miew ™ ‘

VvV VvV VvV vV VvV VvV VvYyYVYyYY

v

¥  Programming

I It >

l 2

(o =2 l (¢} [

Structures Array
> mar] >

=
Mumeric Boolean

[2o2]
o
File IjO Waveform
>
o -
.--> o

Synchronization Graphics & So...

Measurement IjO
Instrument IO
Vision and Motion
Mathematics

Signal Processing
Data Communication
Connectivity
Control Design & Simulation
SignalExpress
Express

Addons

Fawvorites

User Libraries

Select a VI...
Statechart

>
.

old

Cluster, Class...

[abc] *

Skring

o>

Dialog & User...

4

Application C...

>

=

:U:_:_i]

Report Gener...

Right-click on the Block Diagram

Available only from the Block Diagram



Customizing Controls and Functions Palettes

i3 Change Visible Palettes

Controls (3]

Q, Search | <, Customi=~=1 You are modifying the Controls palette.
View This Palette As > -

|| ¥ Silver 2
= = > r , Sort Alphabetica @ g

[E Available Palette Categories

Modern ~ €Select AII>_J

Numeric Boo O- - Silver
@ > ' ptions... —_ =
[ﬂ@@] _ . System Deselect All
. | =] — [ | Classic
Array, Matrix... List, Table & ... Graph Express
Control Design & Simulation Bestore Defnolt

NET & ActiveX
Signal Processing
Addons

User Controls
Select a Control...

e

To change the category visibility of the Functions palette, invoke this

DO th|s for both the contrOIS dialeg box frem the Functions palette.
Palette and the Functions Palette G

C—

OK Cancel Help



= LabVIEW MathScript

LabVIEW =
This is the core LabVIEW installationthat installs | -

the LabVIEW Programming Environment.

= LabVIEW ¢ |

IL;) Create Project l\» [/) Open Existing

-~LabVIEW MathScrlpt RT Module

Recent Project Templates All

~

Variables | Script History

> (alEsS| ] [%][H][0) [#8)cE
1

- o IEl

0 ||0« || »0

Eifiiii This module is a text-based tool that is very 5|m|Iar to MATLAB. The syntax

»/| Set Up and Explore

-1 is similar to MATLAB, you can create and run so-called m files, etc. The
module is available from the Tools menu inside LabVIEW.

Control & Simulation

LabVIEW Control De5|gn and Simulation Module

QSearch I @QCustomize"
This module is used for creating Control and Simulation applications W|th
LabVIEW. Here you will find PID controllers, etc. The module is available e |
as a palette on your block diagram. PID Fuzzy Logic
Search{l S Customize~ E » l
I SN [ | - _‘%" ;-.

DAGmx
.
Stop

USB-6008, NI TC-01, etc. inside LabVIEW. The module is available as a palette on

Write Nod¢

zl your bIock diagram.

Dev Config Task Config,

= Read Node

LY

DAQmx is the Hardware Driver needed in order to use hardware dewces like NI
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These are small-scale processes we have at HiT

Dynamic Systems Examples

L0 Ve o o | Mathematical Models (differential equations):

1
Alt 2 (Time constant/1.order):

.1
h = Z[1<pu — K, h|

Alt 3 (Nonlinear):

Water Tank:

Alt 1 (Integrator): h

| pgh
h=Z Kpu—quT

. 1
Tout = e_t{_Tout + [Khu(t _ ed) + Tenv]}

T — Temperature in the tube



Dynamic Systems

Dynamic system represented as a differential equation (1.order system):

X = —ax + bu

dx /
S Note We can “easily” create a block diagram from the differential
dt equation(s)

Dynamic systemrepresented as a block diagram
Integrator symbol

‘lt—)-b;r)Q_x)l XS

%)

a [€s—

When we have the block diagram for the system, we can easily implement it in LabVIEW
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Control and Simulation in LabVIEW

PID Palette in LabVIEW
PID

Control Design & Simulation Palette in LabVIEW

Control & Simulation

1 Q Search ' % Customize~

' ROt

.'O‘fET Fuzzy

PID Fuzzy Logic
1 — ]
2

Simulation  Control Desi

Simulation

& Customize™ |

b i b b
Signal Gener... Signal Arith... Lookup Tables Utilities Graph Utilities
» » > > >
Continuous ... Nonlinear Sy... Discrete Line...  Controllers Estimation
» » Eﬁ;‘ﬁ » »
3BT Q3

Model Hierar... Implicit Syst... Trim & Linea... Optimal Desi... External Mod...

Simulation Palette in LabVIEW

| {} | QSEBrch' %Clstomizev ‘

PID

BS&

PID.vi

PID

E-DE

PID Gain Sch... PID Structure... PID Autotuni...
PID FID FID
I E E: Al:_f.él

PID Setpoint ... PID Control l... PID OutputR...

Control Design
I ¢ | Q Search‘ 2, Customize™ ‘

e b e =0 »
o +p 3 Be
Model Const... Model Infor... Model Conv... Model Interc...

m’ el g ::E’

LH @t ¥

i ';ﬁ?o =
Time Respon... Frequency R... Dynamic Ch.. Model Redu...

» » »

= - Absr

u=-k w—-— E0-=0

State-Space ... State Feedba... Stochastic Sy... Solvers

- ? > » T@:

=l ! e
Analytical Pl... Predictive C... Interactive D... Implementat...

PID

Tl

.. PID Autotuni...

PID

e

PID Online A...

PID
]+ %%

PID EGU to P...

PID

Bf 5

AUTO

PID Autotuni...
FID

t, f,

PID Lead-La...

PID
gL 0|

PID Percenta...

Control Design Palette in LabVIEW

Check that you have all these palettes. Open
the different subpalettes, etc.



LabVIEW Control and Simulation Example

3

File Edit View Project Operate Tools Window Help

Simulation Example with PID.vi Block Diagram =

P | \E”hul'ﬁ' 3 ’15ptAppIication Font |+ ngv“ﬁ;vH@%v H&, *| Search 4 ‘ =

Proportional Gain (Kc)

Jizsh

Summation2 PID

©

Multi

plication

X
X

Example of Simulation (and control) of a
dynamic system based on the blocks in
the Simulation Palette
Su['nmation ator Simulation Time Waveform
& &l =
Multiplication 2
_ XH
X »
. v

We are goingto learn to create such a system (and much more)!



The Simulation palette in LabVIEW

Simulation Palette in LabVIEW

S LS e > mulation Simulation Loop: Similar to a While Loop, but customized for used
( ( together with the Simulation Blocks available in LabVIEW
'I

Cont I&S . . . .

= (I Different Simulation Blocks by Category

g’ g)m > 3 ¥ p»

Co tus NonISy.. D crn Co%er EstilmEa;i]on - ° CO ntl n u O u S SySte mS

» » ?éﬁ » » .
Model Hierar... Implyst... TrimiéligiglLinea... Optiesi... Extern“al-:/l.od... ° Dlscrete SyStemS
~ * Nonlinear Systems
Continuous Linear Systems ° etc

| i I Q Search l €, Customize™ l

Transport Delay

[-B

Integrator Derivative  Transpo
oo oeq
Sk

State-Space  Transfer Fun... Zero-Pole-G...

Continuous ... Continuous ... PID

3¢
H
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Integrator symbol

Simulation Example /

Dynamic system represented as a differential equation

. + X 1
x=—ax +bu > »—lo — s

seta =0.25and b = 2 a [<—
{ {3 Simulation Example.vi Block Diagram A= ﬂ@ ’
File Edit View Project Operate Tools Window Help 3
P & ‘@['»QIE’ 1 llSptAppIication Font |~ Hg“'H:f];'H[ﬁ'Hhﬂ] »| Search Y ] et

Control & Simulation Loop

Multiplication  Summation Integrator Simulation Time Waveform

HOT Naveform Chart
& —| N+ = } } S
% =

OO0

m




Simulation Example - Configuration

In the example the following simulation parameters could be used (right-click on the Simulation
Loop border and select “Configure Simulation parameters...”):

{3 Configure Simulation Parameters @ {3 Configure Simulation Parameters @
‘ Simulation Parameters ’ Timing Parameters | ’ Simulation Parameters ‘ Timing Parameters ’
Simulation Time Enable Synchronized Timing
Initial Time (s) Final Time "] Synchronize Loop to Timing Source
0 = 20 :
Timing Source
Solver Method >ource type
ODE Solver

Runge Tuia 2 fvasable) [z] "I Nan/Inf Check 1 kHz <reset at structure start>

Continuous Time Step and Tolerance

Initial Step Size (s) Other <defined bv source name or terminal> —
0,01 = Source
Minimum Step Size (s) Maximum Step Size (s) 1 kHz
1E-10 = 1 =
. Loop Timing Attributes
Relative Tolerance Absoclute Tolerance Period
0,001 = 1E-7 = 1000 Auto Period
Offset / Phase Priorit
Discrete Time Step . o !
Discrete Step Size (s Deadline Timeout (ms
0,1 Auto Discrete Time 1 1
Signal Collection Processor Assignment
Decimation Mode Processor
0 . Automatic v 2

OK ] [ Cancel ] [ Help ] OK ] [ Cancel ] [ Help ]




Simulation Example - Solutions

{3 Simulation Example.vi Block Diagram

(o]l O]

File Edit View Project Operate Tools Window Help

DR :\@Ihnlla’ 3 ’15ptAppIication Font |« ||3;v H'-'ﬁav [ |Bv$v ‘

*| Search

N

1

Control & Simulation Loop

olication  Summation Integrator Simulation Time Waveform

[Waveform Chart
P

Multiplication 2

.

LU

s

m

Try with different values for u

o )lo /s

indow Help

X = —ax + bu
seta=0.25and b =2

Correct results? — Check static response:

Step Respons

0 = —axs + bug

b 2

xs=_u5= 8

I L 7 Bl | il

e [ 5

*| Sea

rch

1T

4 |[2]

=

1=
a 0.25

Waveform Chart

Amplitude

10

[ Plto [~ |

We see the Step Response
is as expected!

L

-~
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KpTi 7-d

Control System

PID

74

—

Process >

Sensor

PID Algorithm:

<€

r — Reference Value, SP (Setpoint), SV (Set Value)

y —Measurement Value (MV), Process Value (PV)
e — Error between thereference value and the measurementvalue (e =r —vy)

v — Disturbance, makes it more complicated to control the process

Kp, Ti, Td— PID parameters

K L
u(t) = Kye + ??fo edt + K, T;e



Control System implementation with “Pen & Paper” | v ‘%’
%

Kp T/ 7-d
u y
PID —{ Process >
The transition from “paper” to LabVIEW is
easy, because the implementation is very
similar to the “paper” version
Sensor [«

Control System implementationin LabVIEW

Control & Simulation Loop

Derivative time [s] (Td)
b

Integral time [s] (Ti)
s

Proportional Gain (Kc)
S

Summaticn 2 PID = Simulation Time Waveform
[Waveform Chart

= Tony Process.vi
€ A s

Stop Button 3}t Simulation




Control System implementation with “Pen & Paper”

Controller

—>

Process >

All this is normally
included in the controller

Sensor

<€

The transition from “paper” to LabVIEW is
easy, because the implementation is very
similar to the “paper” version

\

Here we have used an ordinary While Loop

(which is recommended!)

While Loop

Wait (ms)

Control System implementationin LabVIEW

Process.vi
— ~ aveform Chart

rController.w.n X L » PDBL |

|
b |2
2

Stop Button

= -



PID Control in LabVIEW

Alternative 1: i
, _ Alternative 2:
PID Palette in LabVIEW (PID Toolkit)
Continuous Linear Systems
PID | 1@ l C{Search l €, Customize¥ |
v Transport Delay
1 Q Search | % Customize 5
= E| iy
P'_Dd 45'-0 PID P'P.’ Integrator Derivative  Transport De...
B/ iy > "ol B =7 -
C
PDvi  PID Advance... \BID Advance,. PID Autotuni... PID Autotuni... =
o e 5T T T State-Space  Transfer Fun " |
= (o This alternative
fre ‘o N D - (] |
: . . _ _ uses seconds!
PID Gain Sch... PID Structure... PID Autotuni... PID Online A... PID Lead-La... Continuous ... Continuous ...
FID PID PID PID PID
L.\ fir I“‘!i,_—““ EE+%E B

PID Setpoint ... PID Control l... PID OutputR... PID EGUto P... PID Percenta...

' PIDE' Advanced.vil
A T
Note! The functions “PID.vi” and “PID Advanced.vi” requires that Tiand Td arein minutes, = ____ | ™ = FON

Kc Scaling s

while it’s normal to use seconds as the unit for these parameters. You can use the following

piece of code in order to transform them:
This means we enter values for Ti and Td in secons on the Front Panel and the values are :

converted to minutes in the code. 0]
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X

<

LabVIEW PID Example
—ax _I_ bu seta =0.25and b = 2

i~

{3 simulation Example.vi Block Diagram

=8| EER ()

File Edit View Project Operate Tools Window Help

Ic{) I@] \jl 11 H @ l |9‘;] IL’DI'E. 3 |15pt Application Font |~ Hg,;;v ”Tn;v l I%%v Hiffél *| Search

4 |[?]

Control & Simulation Loop

slication  Summation Integrator Simulatiocn Time Waveform

Naveform Chart|

::{_9 » 5] |

Multiplication 2
x|
* |4 |ﬁ DBL b

m

-

[

We will replace uin the previous example with the built-in PID Controller (use Alternative 2)

Toop
PID |

PID




X

PID Example - Solutions

—ax + bu

seta =0.25and b = 2
Front Panel:
3 Simulation Example with PID.vi Front Panel = 1=
File Edit View Project Operate Tools Window Help ] o
2> || (L)1 || 15pt Application Font |~ || 3o~ || oo~ ||t (|29 v Search 1 [2|B e
~
Proportional Gain (Kc) [ YVaveform 2z
r N [a)
:T:|'|—‘ l,x|4—‘ 10- Plot 0 W ]
Integral time [s] (Ti) .
=l
Derivative time [s] (Td) 9 § 6-
rfTv ) =
l,r|1 0.500279 g— 4_/\
————— <
2_
: o ] : 1 E W
(&) ,ny
=1]0.25 =il 2 Time




PID Example - Solutions
x — _ax + bu seta =0.25and b = 2

Block Diagram:

i3 Simulation Example with PID.vi Block Diagram
File Edit View Project Operate Tools Window Help

> | :IE] ’L.QIIE’ ) I 15pt Application Font |« ngv l[ 2 Subsystem Configuration *| Search

.. Parameter Information
Polymorphic instance

i 3 Academic o Param_eter source
Control & Simulation Loo Termial y

Parameters

Derivative time [s d ‘ Parameter Name Value A
e ~Proporional Gain| 1|
€ Integral time [s] (T 1
4 Derivative time [s] 0

Right-click (Configuration) on the PID block
to select Kp, Ti, Td as Inputs (->Terminals)

Summation2 PID| P i Integrator Simulation Time Waveform
plication Summation J Naveform Chart

3 R I N =

plication 2

el

{(DBL &







Simulation Parameters

Simulation Time
Initial Time (s)

Next Step: Continuous Simulation

Timing Para

inal Time

o Sl

Solver Method
ODE Solver

|Runge-Kutta 1 (Euler)

[v] [JNan/inf Check

p and Tolerance
Step Size (s)
0.1 ey

Relative Tolerance

n NN -
0.001 =

Discrete Time Step
Discrete Step Size (s)

n -
0.1 =

Signal Collection
Decimation

0

Maximum Step Size (s)
1 s

Absolute Tolerance
1E-7 =

Auto Discrete Time

P

’ Simulation Parameters | _Timing Parameters

Enable Synchronized Timing Simulation in “Real Time”

Synchronize Loop to Timing Source

Timing Source
Source type
A
1 MHz Clock
1 kHz <reset at structure start>
1 MHz <reset at structure start>
Synchronize to Scan Engine

QOther <defined bv source name or terminal>

Right-click on the Simulation Loop
border and select “Configure
Simulation Parameters...”

[] Auto Period
Priority

100

Timeout (ms)
-1

Processor

Add a Stop Button
and a “Halt Simulation” block

Stop Button

Halt Simulation




PID Example — Continuous Simulation - Solution
SN

i3 Simulation Example with PID - Continuous.vi Front Panel

File Edit View Project Operate Tools Window Help E
lc{}‘@l @ I 15pt Application Font |~ I [- Search 4 l a1
A

Waveform Chart

Proportional Gain (Kc) t — . .
Eiemml e | - . . { Plot0 [~ |
I \ 4.00
Integral time [s] (Ti) 7
o -
Derivative time [s] (Td) Y ‘ 437
=i[o 0.499996 '?;14“' =
L J { J GES
2_
1_
3 b 0-§ I I | . | | 1

1 1
' - ' ,T oY 0 r
(211025 J 212 Time Il stp

F-Trop;r’(ional Gain (Kc)

iz

The Simulation now runs until you press

Summation2  PID | ’ olication Summation  Integrator Simulation Time Waveform

the Stop button EEE = ; O 5 =
B[ f

Naveform Chart

Multiplication 2

I

X|¢—[DBL»
+—{[oBLY
Stop Button it Simulation
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Create New

B VI

Simulation Subsystem File > New..

{=] Polymorphic VI
3 From Template

.. & Project
A Way to structure your code, similar to SubVls =13 Other Files
This is the recommended way to do it! — You can easly reuse your Subsystems in B Class
. 1, Custom Control
different VIs and your code becomes more structured!

Select File ->New ..., Then choose “Simulation
Subsystem”. Copy (or move) the blocks containing your
Derivativetime[s] (Td) | process into the New VI (Simulation Subsystem)

2z
DEL

integral tiEne [s] (Ti}E

23

Create a Subsystem of this part (your process model)

Proportional Gain (Ke) || __ __ __
1131.23%

Summation 2

Multiplication Summation  Integrator | Simulation Time Waveform

@4(_ = & = —’6_9—4 E 5 >
N ]— -

x

plication 2

[DBL#¥
—————————————————— Stop Button  Hajt Simulation

.................

We will change your code above where you create a Simulation Sub System for your Process




Simulation Subsystem - Solutions

M| Error )

Control & Simulation Loop

Derivative time [s] (Td)

Summation 2

. Simulation Time Waveform
= Process.vi ST aveform Chart|
)

=3

Stop Button it Simulation

‘T‘

File -> New...

C N File Edit View Project Operate Tools Window Help
re.a—.te W m@‘ |;||E||L.u|l3’ . |15ptAppIication Font |~ ngv oY | |q-‘l‘ I‘g) E
=0V -
 |md Blank VI
=, Polymorphic VI plication ~ Summation  Integrator
& From Template

: -\ ¥ PDBL
E} Project N '{—7 '@ El_il
=) Other Files

B! Simulation Subsystem

Multiplication 2
; I
Class X +—]{Cosey
@ Custom Control







Simulation Subsystem 2 (PID Controller)

Control & Simulation Loop

Derivative time [s] (Td)
] DBL K

Integral time [5] Ti) Create a Subsystem of this part (the PID controller)

l DBL k
Proportional Gain (Kc)
] DBL ¥ 1

Summation2 PR, [ . Simulation Time Waveform
<-> Bons Process.vi \Waveform Chart]|
W+ =

Sl

e

|
i
I
|
i
I
|
i
I
|
i
1
|
i
I
|

Stop Button 1zt Simulation

’
ETF:

We will change your code above where you create a Simulation Sub System for the PID Controller as well.




Simulation Subsystem — Solutions2

P
File Edit View Project Operate Tools Windoy

File Edit View Project Operate Tools Window Help

(28] [0 159t Applcton Font |~ | S i - |66 TSemen L [PHIH DEEDaEDEEEN

r Waveform Chart D [s] (Td)
r erivative time [s;
Plot0 [\, @

ain
Integral time [s] (Ti)
|4.oo e
Proportional Gain (Kc)
=

File Edit View Project Operate Tools Window Help

\:IEE@ 3 |15ptAppIicationFont |~ ||g,;.v ”'-'uh‘nv”q-{ l@

Amplitude

Multiplication Summation  Integrator
in SR R

Multiplication 2

Jow your code has become
really simple to understand!

r| Controller.vi ; Simulation Time Waveform
[DBLY Process.vi Waveform Chart|
Process

Note! You mayselect

differenticon style
Stop Button it Simulation
Configuration... Dynamic
T I
Open Subsystem E:Xt SL
Redraw lcon press
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Simulations using a While Loop

Note! The Simulation Loop has some drawbacks/is more complicated to use than an ordinary While
Loop. If we use Simulation Subsystems, we can use them inside a While Loop instead! -which
becomes very handy!

('/'I

While Loop Simulation Subsystems

b vi
/\ Frocessv [Waveform Chart|

Controller.vi »OBL

r b P

A%
[
-

K<

—

So for real applications that involves more than just
Wait (ms) simulations (such as DAQ, File Logging, PID control of
. Stop Button
500 the real process, etc.), | recommend to use a While
Loop instead of a Simulation Loop. @’

‘We will add the Controllerand Process Subsystemsinside a While loop as shown above
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